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INTRODUCTION 
Adobe Photoshop 2026 is a comprehensive creative platform designed for 

professional image editing, graphic design, digital art, and visual content creation. 

It combines powerful core tools—such as layers, masks, selections, filters, and 

adjustment controls—with advanced AI-driven technologies that simplify 

complex tasks and enhance creative precision. From basic photo corrections to 

high-end compositing and visual storytelling, Photoshop 2026 supports every 

stage of the creative process. 

This version of Photoshop places strong emphasis on intelligent automation, 

speed, and flexibility. Enhanced AI features assist with object selection, 

background removal, image enhancement, and content generation, allowing 

users to achieve high-quality results in less time. Improved performance ensures 

smoother handling of large files, high-resolution images, and multi-layered 

projects, while modern workspace refinements make tools easier to access and 

workflows more efficient. 

Adobe Photoshop 2026 also integrates seamlessly with cloud services and other 

Adobe applications, enabling collaboration, file synchronization, and cross-

platform creativity. Users can work with photography, typography, illustration, 

web graphics, social media assets, marketing designs, and print-ready projects—
all within a single, unified environment. 

This book provides a complete and practical guide to everything Adobe 

Photoshop 2026 entails. It covers essential concepts such as the workspace, tools, 

layers, and color management, then progresses into advanced techniques 

including professional retouching, compositing, typography, effects, and creative 

workflows. Whether you are new to Photoshop or upgrading your skills for 

modern design demands, this guide equips you with the knowledge and 

confidence to use Photoshop 2026 effectively, creatively, and professionally. 

SYSTEM REQUIREMENTS FOR ADOBE PHOTOSHOP 2026 

Like most major software developers, Adobe publishes official system 

requirements for Photoshop. However, these specifications usually represent the 
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minimum needed to launch the software, not the level of performance required 

for serious or professional work. 

If you plan to use Photoshop 2026 for high-resolution photography, AI-powered 

tools, compositing, or hybrid photo–video workflows, your system will need 

significantly more power than Adobe’s baseline recommendations. 

Official vs. Real-World Requirements (2026) 

Adobe Minimum Requirements are suitable for light editing and basic tasks. 

Professional-Grade Recommendations are designed for speed, stability, and 

future-proof performance. 

▪ Processor 

▪ Adobe Minimum: Multicore Intel or AMD processor (2 GHz or faster) 

▪ Recommended: Intel Core Ultra 7 or AMD Ryzen 7 for smooth 

multitasking and faster renders 

▪ Memory (RAM) 

▪ Adobe Minimum: 16 GB 

▪ Recommended: 32 GB DDR5, essential for large files, AI tools, and 

layered projects 

▪ Graphics Card (GPU) 

▪ Adobe Minimum: DirectX 12–compatible GPU with 1.5 GB VRAM 

▪ Recommended: NVIDIA RTX 5060 or 5070 with at least 8 GB VRAM for 

AI features, filters, and accelerated rendering 

▪ Storage 

▪ Adobe Minimum: 20 GB available space 

▪ Recommended: 1 TB NVMe SSD for fast file access, RAW images, and 

4K assets 

▪ Operating System 

▪ Adobe Minimum: Windows 10 or 11 (64-bit) 

▪ Recommended: Windows 11 Pro (64-bit) for better hardware 

optimization and long-term support 

Minimum Photoshop Requirements for macOS 

For Mac users, Adobe lists the following baseline specifications: 
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▪ Processor: 64-bit Intel or Apple-supported processor, 2 GHz or faster 

▪ RAM: 8 GB (16 GB or more strongly recommended) 

▪ Storage: At least 4 GB of available disk space 

▪ Graphics: GPU with DirectX 12 support and 2 GB of memory 

▪ Operating System: macOS Mojave (version 10.14) or later 

▪ Display Resolution: 1280 × 800 minimum 

▪ Internet Connection: Required for activation and updates 
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CHAPTER ONE 

GETTING STARTED 
Getting started with Adobe Photoshop 2026 involves navigating a heavily AI-

integrated workspace. As of early 2026, the software is available as the full 

professional version (Version 27.3) 

HOW TO DOWNLOAD AND INSTALL THE ADOBE PHOTOSHOP 

2026 FREE TRIAL (STEP BY STEP) 

This section walks you through downloading, installing, and safely canceling the 

Adobe Photoshop 2026 free trial so you can explore all features without getting 

charged. 

Step 1: Go to Adobe’s Official Website 

Open your web browser and visit Adobe’s official website. 

 

Sign in with your existing Adobe ID, or create a free account if you don’t already 
have one. 
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Step 2: Download Creative Cloud Desktop 

Once logged in, download and install the Adobe Creative Cloud Desktop 

application. 

 

Wait for the installation to finish before moving to the next step. 

 

Step 3: Locate Photoshop in Creative Cloud 

After Creative Cloud opens: 

1. Click Apps on the left-hand menu 
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2. Find Photoshop in the list 

3. Click on Photoshop and select Free Trial 

 

Step 4: Start the Free Trial 

Click the Free Trial button and choose a subscription plan. 

Then click Continue. 

Important: You will not be charged immediately. Adobe only bills you after the 

trial ends. 
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Step 5: Add Payment Information 

Even though it’s a free trial, Adobe requires you to enter credit card details. 

▪ The charge will be $0 

▪ Your card is only used for verification 

 

Once your information is submitted, Photoshop 2026 begins downloading 

automatically. 
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Step 6: Use Photoshop During the Trial 
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▪ The free trial lasts 7 days 

▪ You get full access to all Photoshop 2026 features 

▪ No limitations during the trial period 

Enjoy exploring Photoshop just like a paid user. 

How to Cancel the Adobe Photoshop Free Trial (Avoid Charges) 

If you don’t plan to subscribe, follow these steps before the trial ends. 

Step 7: Sign In to Your Adobe Account 

Go back to Adobe’s website and log in using the same Adobe ID you used to start 

the trial. 

Step 8: Manage Your Plan 

1. Go to Plans & Payments 

   

    

2. Click Manage Plan 

3. Select Cancel Your Free Trial 
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Step 9: Confirm Cancellation 

▪ Adobe will ask you to verify your identity 

▪ You may be asked to select a reason for canceling (any option works) 

▪ You may see discount offers—these can be skipped 

Continue following the on-screen instructions until you reach the confirmation 

screen. 

Step 10: Trial Access Continues Until Expiry 

Once canceled: 

▪ You will not be charged 

▪ You can still use Photoshop until the 7-day trial period ends 

PHOTOSHOP HOME SCREEN OVERVIEW 

The Photoshop Home screen is your starting point. It’s designed to help you 
quickly access files, tools, tutorials, and creative resources—all in one place. 

Launch Photoshop 

When you open Photoshop, the Home screen appears automatically. This screen 

gives you an overview of what’s new and what you’ve been working on. 

Explore What’s on the Home Screen 

The Home screen includes several helpful sections: 

▪ Feature Highlights – Stay up to date with the latest Photoshop updates 

and new tools. 

▪ Tutorials – Learn essential concepts, workflows, tips, and shortcuts 

directly inside Photoshop. 
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▪ Recents – Quickly open your most recent cloud documents, including files 

shared with you. 

▪ Keyword Filters – Search and filter your cloud documents by name or 

keyword. When you’re offline, cloud-only files appear greyed out. 

Photoshop also displays personalized content here, tailored to your experience 

level and Creative Cloud subscription. 

 

Return to the Home Screen Anytime 

While working on a document: 

▪ Click Home in the Options bar to return to the Home screen. 

▪ Press Esc to exit the Home screen and return to your open document. 

Use the Main Home Screen Buttons 

At the top of the Home screen, you’ll find quick-access options: 

▪ New File – Create a new document using preset templates. 

▪ Open – Open an existing Photoshop file. 

▪ Home – Return to the Home screen at any time. 

▪ Learn – Access guided tutorials for beginners and advanced users. 

▪ Your Files – Browse and manage all your stored documents. 
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Manage Your Files Efficiently 

Under Your Files, documents are organized into clear categories: 

▪ Shared with You – Files that others have shared with you. 

▪ Lightroom Photos – Synced Lightroom images ready to be imported into 

Photoshop. 

▪ Deleted – Files removed from cloud storage, with options to restore or 

permanently delete them. 

PHOTOSHOP WORKSPACE: UNDERSTANDING THE INTERFACE, 

ZOOMING, AND PANNING 

 

A. Application bar B. Panels C. Tools panel D. Document window E: Options bar F: Notifications 

When you’re new to Photoshop, learning the workspace early makes everything 

easier. Once you understand where tools live and how to move around your 

image, editing becomes faster, smoother, and far less intimidating. 

Step 1: Understand the Document Window 

At the center of the screen is the Document Window. 
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This is your main canvas—the area where you view and edit your image. Every 

adjustment, brush stroke, or design change happens here. 

Step 2: Explore Panels on the Right 

On the right side of the workspace, you’ll see panels such as Layers, Properties, 

Color, and Swatches. 

 

These panels help you control and manage different aspects of your project. 
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▪ Panels are grouped together using tabs 

▪ Click a tab to switch between panels in the same group 

▪ For example, click Swatches to view colors, then click Color to return 

 

If a panel is missing, you can reopen it anytime. 

Step 3: Open Hidden Panels from the Menu 

To show a panel that isn’t visible: 

1. Go to the Window menu at the top 

2. Click the panel name you need (for example, Brushes) 

This ensures you always have access to the tools relevant to your work. 

Step 4: Reset the Workspace if Needed 

Panels can be moved, resized, or closed. 

If things get messy, you can reset everything: 

1. Click the Workspace button in the upper-right corner 

    

2. Select Reset Essentials 



` 15 

This restores Photoshop to its default layout. 

Step 5: Use the Toolbar on the Left 

       

On the left side of the screen is the Toolbar. 

This contains all the core tools for painting, selecting, retouching, and navigating 

your image. 

▪ Hover over a tool to see a tooltip explaining what it does 

▪ Some tools are grouped together—look for a small triangle in the corner 

▪ Click and hold a tool to reveal others in the same group 

▪ Click to select the tool you want to use 

Step 6: Adjust Tools Using the Options Bar 

Above the Document Window is the Options Bar. 

 

This bar changes depending on the tool you select. 

For example: 
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▪ Select a Selection Brush, and you’ll see options like brush size 

▪ Choose a different tool, and its specific settings appear instead 

Each tool has its own customizable controls here. 

Step 7: Use the Contextual Task Bar 

 

The Contextual Task Bar is a floating, smart menu that shows the most relevant 

next steps based on what you’re doing. 

▪ Working with text? You’ll see font and size options 

▪ Drawing shapes? You’ll see fill color, stroke color, and stroke width 

It updates automatically as your task changes. 

Step 8: Zoom In and Out of Your Image 

To work accurately, you’ll often need to zoom. 

1. Select the Zoom Tool from the Toolbar 

2. Click on the area you want to zoom into 
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3. Drag right to zoom in 

4. Drag left to zoom out 

This helps you focus on fine details or see the full image. 

Step 9: Pan Around the Image 

Once zoomed in, you’ll need to move around the canvas. 

1. Select the Hand Tool from the Toolbar 

2. Click and drag to move across the image 

This allows you to work on different areas without changing zoom levels. 

PHOTOSHOP WORKSPACE PREFERENCES EXPLAINED 

Workspace Preferences control how Photoshop’s interface looks and behaves. 
These settings help you customize panel behavior, document layout, and overall 

workspace organization. 

Open Workspace Preferences 

Go to Edit → Preferences → Workspace. 
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This section focuses entirely on layout and interface behavior. 

 

Auto-Collapse Iconic Panels 

▪ Unchecked: Panels stay open until you manually close them. 

▪ Checked: Panels automatically collapse when you click anywhere else. 

Best for: 
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▪ Keep unchecked if you frequently switch between panels. 

▪ Check it if you prefer a cleaner, more minimal interface. 

Auto-Show Hidden Panels 

▪ When enabled, panels temporarily appear when you move your cursor to 

the edge of the screen. 

▪ When disabled, panels stay hidden until you open them manually. 

Recommended: Keep this option checked for faster access to hidden panels. 

Open Documents as Tabs 

▪ Checked: Images open as tabs at the top of the workspace. 

▪ Unchecked: Images open as floating windows. 

Best for: 

▪ Tabs: Working on one image at a time. 

▪ Floating windows: Comparing multiple images side by side. 

Enable Floating Document Window Docking 

This option only applies if you use floating windows. 

▪ Checked: Floating documents can be dragged and snapped back into the 

tab bar. 

▪ Unchecked: Floating windows stay separate and cannot be docked. 

Tip: Enable this if you switch between tabbed and floating layouts. 

Large Tabs 

▪ Makes tabs and some panel items (like Color, Swatches, and Gradients) 

slightly larger. 

▪ This is a subtle visual change. 

Recommended: Keep it checked for better visibility. 

Align UI According to OS Settings 
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▪ Matches Photoshop’s interface direction to your operating system. 

• When off, Photoshop uses Adobe’s default UI alignment. 

Optional: Turn this on if you want Photoshop to visually match your OS layout. 

Enable Narrow Options Bar 

Found under More Options. 

▪ Reduces the height of the Options Bar. 

▪ Useful for smaller screens or limited workspace. 

Recommended: Leave unchecked unless screen space is tight. 

Restore Default Workspaces 

Click Restore Default Workspaces to reset all custom workspace layouts. 

You can also: 

▪ Go to Window → Workspace 

▪ Choose presets like Essentials, Graphic and Web, Motion, or Painting 

▪ Use Reset Essentials to quickly restore the default layout 

Final Tip 

If your workspace becomes cluttered or confusing, resetting it through 

Preferences or Window → Workspace → Reset Essentials is the fastest way to 

start fresh. 

HOW TO FIND MISSING TOOLS AND CUSTOMIZE THE 

TOOLBAR IN PHOTOSHOP 

Photoshop lets you fully customize your toolbar—so if a tool is missing or your 

workspace feels cluttered, you can fix it in minutes. Here’s how to find hidden 
tools, reorganize them, and even save your own toolbar layout. 

Step 1: Open the Toolbar Editor 

1. Look at the bottom of the toolbar and click the three dots (⋯). 
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2. Click Edit Toolbar. 

3. A new panel opens: 

▪ Left side: Tools currently visible in your toolbar. 

▪ Right side: Hidden or unused tools. 

 

Step 2: Find and Add a Missing Tool 

▪ If a tool (for example, the Remove Tool) is missing: 

1. Locate it on the right-hand side. 

2. Click and drag it into the toolbar area on the left. 
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3. Drop it where you want it. 

▪ If you place it outside any group, it appears as a standalone tool. 

▪ Click Done, and the tool immediately becomes available. 

Step 3: Group Tools the Way You Want 

If you prefer tools to be grouped (as they are by default): 

1. Click the three dots (⋯) again → Edit Toolbar. 

2. Drag the tool into an existing group (for example, the Spot Healing Brush 

group). 
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3. Adjust its position within the group by dragging it up or down. 

4. Click Done to apply the changes. 

Step 4: Reorder Tools Inside a Group 

▪ Open Edit Toolbar again. 

▪ Drag a tool within its group to move it higher or lower. 

▪ This changes the order in which tools appear when you click and hold on 

that group. 

Step 5: Remove Tools You Don’t Use 

Unused tools take up space, so feel free to remove them: 

▪ Examples of tools you might not need: 

▪ History Brush 

▪ Art History Brush 

▪ Paint Bucket Tool 

▪ Simply drag unwanted tools out of the toolbar and into the hidden tools 

area. 

 

Once done, click Done and enjoy the extra space and cleaner layout. 

Step 6: Reset the Toolbar to Default 

If things get messy: 

1. Click and hold the three dots (⋯). 
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2. Select Edit Toolbar. 

3. Click Restore Defaults. 

 

4. Click Continue to confirm. 

Your toolbar instantly returns to Photoshop’s original layout. 

Step 7: Save Your Custom Toolbar as a Preset 

If you’ve created a toolbar layout you like: 

1. Open Edit Toolbar. 

2. Click Save Preset. 

3. Give it a name (for example, My Preset). 

4. Click Save. 

You can now: 

▪ Reset to defaults anytime 

▪ Click Load and restore your custom toolbar instantly 

Step 8: Switch Between One-Column and Two-Column Toolbars 
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▪ Click the double-arrow icon at the top of the toolbar: 

▪ One click → single-column toolbar 

▪ Click again → two-column toolbar 

Choose whichever layout feels more comfortable. 

Final Tip: Using the Remove Tool 

Once the Remove Tool is visible: 

▪ Draw a loop around the object you want to remove. 

▪ Photoshop automatically removes it from the image. 

KEYBOARD SHORTCUTS IN PHOTOSHOP 

Using keyboard shortcuts can dramatically speed up your workflow and make 

editing feel more natural and efficient. 

How to View Keyboard Shortcuts 

You can view the complete list of keyboard shortcuts directly inside Photoshop: 

1. Open Photoshop. 

2. Go to Help in the top menu. 

3. Select Keyboard Shortcuts. 

This allows you to explore, learn, and customize shortcuts based on your 

workflow. 

Essential Photoshop Keyboard Shortcuts 

General Photoshop Shortcuts 

Action Windows macOS Description 

Copy Ctrl + C Cmd + C Copies the selected item 

or layer 

Paste Ctrl + V Cmd + V Pastes content from the 

clipboard 

Cut Ctrl + X Cmd + X Cuts the selection and 

copies it 

Undo Ctrl + Z Cmd + Z Reverses the last action 


